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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard,
flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device
and the AC adapter comply with the user-accessible surface temperature limits defined by
the International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP Pavilion g4 Notebook PC

Processors

2nd Generation Intel® Core™ processors:

Intel Core i5-2450M processor (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/
3.0 MB L3 cache, dual core, 35 W)

Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)

Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)

Intel Pentium® processor:

Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W)

Chipset

Intel HM76 Express chipset

Graphics

Internal graphics (UMA):

e Intel HD Graphics 3000 on computer models equipped with a 2nd Generation Intel
Core processor (Intel Core i5-2450M or i3), supports DX10

e Intel HD Graphics on computer models equipped with an Intel Pentium processor,
supports DX10

Switchable discrete graphics:

e AMD Radeon HD 7670M with 2048 MB of dedicated video memory (128 MBx16
DDR3 @ 900 MHz x 8 modules); 128 bit M2 package, supports HD Decode, DX11,
HDMI, PX5, and BACO

e AMD Radeon HD 7670M with 1024 MB of dedicated video memory (64 MBx16
DDR3 @ 900 MHz x 8 modules); 128 bit M2 package, supports HD Decode, DX11,
HDMI, PX5, and BACO

Display Panel

35.6 cm (14.0 in), high-definition (HD), light-emitting diode (LED), SVA BrightView
(1366x768) display; typical brightness: 200 cd/m? (nits)

All display assemblies include 2 wireless local area network (WLAN) antenna cables

Supports 16:9 ultra-wide aspect ratio

Memory

2 customer-accessible/upgradable memory module slots

Supports dual-channel memory

Supports up to 8192 MB of system RAM

DDR3-1333 MHz (DDR3-1600 downgrade to DDR3-1333), for a 2nd Generation Intel
Core processor (Intel Core i5-2450M or Intel Core i3) or Pentium processor

Supports the following configurations:

e 8192 MB total system memory (4096x2)

e 6144 MB total system memory (4096x1 + 2048x1)
e 4096 MB total system memory (4096%1 or 2048x2)
e 2048 MB total system memory (2048%1)




Category Description

Hard drives Supports 6.35 cm (2.5 in) hard drives in 9.5 mm (.37 in) and 7.0 mm (.28 in) thicknesses

Customer-accessible

Serial ATA (SATA)

Supports HP 3D Drive Guard

Supports the following single hard drive configurations:
e 1TB, 5400 rpm, 9.5 mm

° 750 GB, 7200 rpm, 9.5 mm

e 750 GB, 5400 rpm, 9.5 mm

e 640 GB, 5400 rpm, 9.5 mm

e 500 GB, 7200 rpm, 9.5 mm

° 500 GB, 5400 rpm, 9.5 mm

e 320 GB, 7200 rpm, 7.0 mm

° 320 GB, 5400 rpm, 7.0 mm

Optical drive Fixed

SATA

12.7 mm tray load

Customer-accessible

Supports Blu-ray ROM DVD+R/RW Super Multi Double-Layer Drive

Supports DVD+RW Super Multi Double-Layer Combo Drive

Supports zero-power optical drive

Audio and video One digital microphone

HD audio

Supports Dolby Advanced Audio v2

2 Pavilion-branded Altec Lansing speakers

Supports Microsoft® Premium requirements

VGA webcam (fixed, no tilt) with activity LED, 640x480 by 24 frames per second

Ethernet Integrated 10/100 network interface card (NIC)

Wireless Integrated wireless local area network (WLAN) options by way of wireless module

Two WLAN antennas built into display assembly

Support for Intel Wireless Display and Wireless Music

Customer-accessible

2 Chapter 1 Product description



Category

Description

Support for the following WLAN formats:

e  Atheros 9485GN 802.11b/g/n 1x1 WiFi Adapter and 3012 Bluetooth 4.0 Combo
Adapter (select models only)

e  Atheros HB125 802.11b/g/n 1x1 WiFi Adapter (select models only)
e  Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

e  Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination
adapter (select models only)

e Intel Centrino® Wireless-N 2230 802.11b/g/n 2x2 WiFi and Bluetooth Combo
Adapter

e Ralink RT5390BC8 802.11b/g/n 1x1 WiFi and Bluetooth 3.0+HS Combo Adapter
e  Ralink RT5390F 802.11b/g/n 1x1 WiFi Adapter

External media card

HP Multi-Format Digital Media Reader supports the following digital card formats:
e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  Secure Digital High Capacity (SDHC) Memory Card

e  Secure Digital Extended Capacity (SDXC) Memory Card

Internal media card

One half-size Mini Card slot for WLAN

Ports

e  Smart Pin AC power adapter
e  Audio-in (mono microphone)
e  Audio-out (stereo headphone)
e  HDMI version 1.4 supporting up to 1920x1200 @ 60Hz
e RJ-45 (Ethernet, includes link and activity lights)
e USB 3.0 (2 ports)
e USB 2.0 (1 port)
e  VGA (Dsub 15 pin) supporting:
° 2048x%1536 external resolution @ 75Hz

° Hot plug and unplug and auto-detection for correct output to wide-aspect vs.
standard aspect video

Keyboard/pointing devices

Full-size, textured, island-style keyboard

TouchPad with gesture support

Taps enabled by default

Power requirements

90 W AC adapter with localized cable plug support (3-wire plug with ground pin, supports
3-pin DC connector) (for computer models equipped with a graphics subsystem with
discrete memory only)

65 W AC adapter with localized cable plug support (3-wire plug with ground pin, supports
3-pin DC connector) (for computer models equipped with a graphics subsystem with
UMA memory only)
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Category

Description

Support for the following batteries:

6 cell, 2.20 Ah (47 Wh) Li-ion battery
6 cell, 2.55 Ah (55 Wh) Li-ion battery (select models only)

Supports fast charge

Security

Security cable slot

Operating system

Preinstalled:

Microsoft Windows® 7 Home Professional 64 bit
Windows 7 Home Premium 64 bit

Windows 7 Home Basic 64 bit

FreeDOS

SUSE Linux

Serviceability

End-user replaceable parts:

AC adapter

Battery

Hard drive

Keyboard

Memory modules (2)
Optical drive

WLAN module

Chapter 1 Product description



2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLAN devices.

(2) Internal microphone Records sound.

(3) Webcam Records video and captures still photographs. To use
the webcam, select Start > All Programs >
CyberLink YouCam > CyberLink YouCam.

(4) Webcam light On: The webcam is in use.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display
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Top

Buttons and speakers

Component Description
1) I Power button e  When the computer is off, press the button to turn on
o the computer.

e When the computer is on, press the button briefly to
initiate Sleep.

e  When the computer is in the Sleep state, press the
button briefly to exit Sleep.

e  When the computer is in Hibernation, press the button
down briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button
will result in the loss of unsaved information.

If the computer has stopped responding and Microsoft
Windows shutdown procedures are ineffective, press and
hold the power button down for at least 5 seconds to turn
off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power Options,
or see the HP User Guide.

(2) Speakers (2) Produce sound.

Chapter 2 External component identification



Keys

CQ ST O®,

Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Displays system information when pressed in combination
with the esc key.

(3) Operating system logo key Displays the operating system menu.

<

(4)

Action keys

Execute frequently used system functions.

(8)

Operating system applications key

Displays a shortcut menu for items beneath the cursor.

Top



Component

Description

1) ﬂ) Power light

White: The computer is on.

Blinking white: The computer is in the Sleep state,
which is an energy-saving mode. The computer shuts
off power to the display and other unneeded
components.

Off: The computer is off or in Hibernation. Hibernation
is an energy-saving mode that uses the least amount
of power.

(2

Caps lock light

White: Caps lock is on, which switches the keys to all capital
letters.

@)

L[]

Mute light

Amber: Computer sound is off.

Off: Computer sound is on.

(4)

)

Wireless light

White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

Amber: All wireless devices are off.

5

TouchPad light

Amber: The TouchPad is off.
Off: The TouchPad is on.

8 Chapter 2 External component identification



TouchPad

Component

Description

()

TouchPad on/off button

Turns the TouchPad on or off.

)

TouchPad light

e  Amber: The TouchPad is off.
e  Off: The TouchPad is on.

(3)

TouchPad zone

Moves the on-screen pointer and selects or activates items
on the screen.

(4)

Left TouchPad button

Functions like the left button on an external mouse.

®)

Right TouchPad button

Functions like the right button on an external mouse.

Top



Left side

Component

Description

(1)

External monitor port
([l

Connects an external VGA monitor or projector.

)

Vents (2)

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

@)

HDMI port

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or audio
device.

(4)

RJ-45 (network) jack

Connects a network cable.

5

USB 3.0 ports (2)

Connect optional USB 3.0 compatible devices and provide
enhanced USB power performance.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

@)

Audio-out (headphone) jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable.

WARNING! To reduce the risk of personal injury, adjust
the volume before using headphones, earbuds, or a
headset. For additional safety information, see the
Regulatory, Safety and Environmental Notices.

NOTE: When a device is connected to a headphone jack,
the computer speakers are disabled.

(8)

n Digital Media Slot

Supports the following digital card formats:
e  Secure Digital (SD) Memory Card

e  Secure Digital Extended Capacity (SDxC) Memory
Card

e  Secure Digital High Capacity (SDHC) Memory Card
e  MultiMediaCard (MMC)

10 Chapter 2 External component identification



Right side

Component

Description

()

Optical drive

Reads and writes to an optical disc.

()

Optical drive light

e  Green or amber: The optical drive is being accessed.

e  Off: The optical drive is idle.

()

Optical drive eject button

Releases the disc tray.

(4)

Power light

€

e  White: The computer is on.

e  Blinking white: The computer is in the Sleep state,
which is an energy-saving mode. The computer shuts
off power to the display and other unneeded
components.

e  Off: The computer is off or in Hibernation. Hibernation
is an energy-saving mode that uses the least amount
of power.

5

Hard drive light

e  Blinking white: The hard drive is being accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(6)

()

USB 2.0 port

Connects an optional USB 2.0 compatible device.

@)

AC adapter light

e  White: The AC adapter is connected and the battery is
charged.

e  Blinking white: The battery has reached a low battery
level.

e  Amber: The AC adapter is connected and the battery
is charging.

e  Off: The computer is using DC power.

(8)

! | Power connector

Connects an AC adapter.

(9

E Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Right side
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Bottom components

4 3
¢y
{ B |
e
Component Description
1) Battery bay Holds the battery.
(2) i Battery release latch Releases the battery from the battery bay.
3) Vents (5) Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
(4) Keyboard access, optical drive, solid-state ~~ The service door provides access to the keyboard, optical

-_
—

E...

drive (SSD)/hard drive bay, wireless
compartment, and memory module
compartment

drive, SSD/hard drive bay, wireless compartment and
memory module compartment.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact customer support through Help and Support.

12 Chapter 2 External component identification



3 lllustrated parts catalog

Service label

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service label.

(D

FOCOOHEX

Serial: JOCCOCOCC IR WWATWRINNN

L

|~ Product: OO0C0CK (IMENNNENIRNTNIR
— Warranty: 1yly0y
Madel: X000

Item

Description

Function

0

Product name

This is the model name for the computer.

)

Serial number

This is an alphanumeric identifier that is unique to each product.

(©)

Product part number

This number provides specific information about the product's hardware components. The

part number helps a service technician to determine what components and parts are

needed.

)

Warranty period

This number describes the duration of the warranty period for the computer.

®)

Model description
(select models only)

This is the alphanumeric identifier needed to locate documents, drivers, and support for

the computer.

Service label
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Computer major components
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Item

Component

Spare part number

()

35.6 cm (14.0 in), high definition (HD), LED, BrightView display assembly (includes webcam, microphone,

wireless antenna transceivers and cable, and display cable):

e RubyRed 683845-001
e  Sparkling Black 683847-001
e  Winter Blue 683846-001

NOTE: For more display assembly spare part information, see Display assembly subcomponents on page 18.

)

Keyboard (includes keyboard cable):

Keyboard with black finish:

e  Foruse in Brazil 680555-201
e  Forusein Canada 680555-DB1
e  Forusein India 680555-D61
° For use in Japan 680555-291
e  Foruse in Latin America 680555-161
e  Foruse in South Korea 680555-AD1
e  Forusein Taiwan 680555-AB1
e  Foruse in Thailand 680555-281
e  Foruse in the United States 680555-001
Keyboard with white finish:
e  Foruse in Brazil 684479-201
e  Foruse in Latin America 684479-161
(3) Top cover (includes TouchPad):
e RubyRed 680574-001
e  Sparkling Black 680576-001
e  Winter Blue 680575-001
(4) Power button board (includes cable) 680560-001
(5) TouchPad LED board (includes cable) 683848-001
(6) TouchPad button board (includes cable) 680559-001
(7) Speaker Kit (includes left and right speakers and cable) 680567-001
(8) System board (includes replacement thermal material):
e  For use only with computer models equipped with UMA video memory 680568-001
e  For use only with computer models equipped with 2048 MB of dedicated discrete 680570-001
video memory
e  For use only with computer models equipped with 1024 MB of dedicated discrete 680569-001
video memory
(9) Intel Platform Controller Hub (PCH) heat sink 683843-001

Computer major components
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Item Component Spare part number

(10) Processor (includes replacement thermal material):

e Intel Core i5-2450M processor (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/3.0 676359-001
MB L3 cache, dual core, 35 W)

e Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, 653340-001
dual core, 35 W)
e Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, 653339-001
dual core, 35 W)
e Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, 664662-001
dual core, 35 W)
(11) RTC battery (includes cable and double-sided tape) 637193-001
(12) Fan and heat sink (includes replacement thermal material):

e  Heat sink for use only with computer models equipped with discrete video memory  680550-001

e  Heat sink for use only with computer models equipped with UMA video memory 680549-001

e Fan 680551-001
(13) Power connector cable 680548-001
(14) USB board (includes cable) 680558-001
(15) Optical drive cable (includes optical drive connector) 680546-001
(16) Battery:

e 6 cell, 47 Whr, 2.20 Ah Li-ion battery 593553-001

e 6 cell, 55 Whr, 2.55 Ah Li-ion battery (select models only) 593554-001
(17) Base enclosure 680544-001

Rubber Feet Kit (not illustrated, includes 4 rubber feet) 680563-001
(18) Hard drive SATA, does not include hard drive bumpers, bracket, or cable):

9.5 mm (0.37 in) x 6.35 cm (2.50 in):

e 1TB, 5400 rpm 676521-001
e 750 GB, 7200 rpm 633252-001
e 750 GB, 5400 rpm 634250-001
e 640 GB, 5400 rpm 669300-001
e 500 GB, 7200 rpm 634925-001
e 500 GB, 5400 rpm 669299-001

7.0 mm (0.28 in) x 6.35 cm (2.50 in):

e 320 GB, 7200 rpm 634862-001
e 320 GB, 5400 rpm 645193-001
Hard Drive Hardware Kit includes hard drive bracket and bracket screws, cable, and 2  682745-001
bumpers)

(19) Memory modules (2, DDR3, 10600, 1333 MHz):
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Item Component Spare part number
e 4GB 641369-001
e 2GB 652972-001
(20) WLAN module:
e  Atheros 9485GN 802.11b/g/n 1x1 WiFi Adapter and 3012 Bluetooth 4.0 Combo 655795-001
Adapter (select models only)
e  Atheros HB125 802.11b/g/n 1x1 WiFi Adapter (select models only) 675794-001
e  Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter and 20702 Bluetooth 4.0+HS 657325-001
Combo Adapter
e  Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination =~ 600370-001
adapter (select models only)
e Intel Centrino® Wireless-N 2230 802.11b/g/n 2x2 WiFi and Bluetooth Combo 670290-001
Adapter
e Ralink RT5390BC8 802.11b/g/n 1x1 WiFi and Bluetooth 3.0+HS Combo Adapter 656120-001
e  Ralink RT5390F 802.11b/g/n 1x1 WiFi Adapter 670691-001
(21) Optical drive (includes bezel and bracket):
e  Blu-ray ROM DVD+R/RW Super Multi Double-Layer Drive 680557-001
e DVD*RW Super Multi Double-Layer Combo Drive 680556-001
(22) Service door (includes 1 captive screw) — available in the Plastics Kit 680561-001
Rubber Kit (not illustrated, includes rubber feet) 680563-001

Computer major components
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Display assembly subcomponents

Item Component Spare part number
(1) Display bezel 680545-001
(2) Webcam/microphone module 680577-001
3) Display Hinge Kit (includes left and right display hinges and brackets) 680554-001
(4) 35.6 cm (14.0 in), HD, LED, BrightView display panel 680562-001
(5) Antenna Kit (includes left and right wireless antenna cables and transceivers) 680539-001
(6) Display Panel Cable Kit (includes display panel cable) 680547-001
(7) Display hinge covers (2) 680553-001
(8) Display enclosure:
e RubyRed 680541-001
e  Sparkling Black 680543-001
e  Winter Blue 680542-001
Display Screw Kit (not illustrated) 680565-001
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Mass storage devices

B_

Item

Component

Spare part number

()

Optical drive (includes bezel and bracket):

e  Blu-ray ROM DVD+R/RW Super Multi Double-Layer Drive 680557-001
e  DVDxRW Super Multi Double-Layer Combo Drive 680556-001
(2) Hard drive SATA, does not include hard drive bumpers, bracket, or cable:

9.5 mm (0.37 in) x 6.35 cm (2.50 in):

e 1TB, 5400 rpm 676521-001
e 750 GB, 7200 rpm 633252-001
e 750 GB, 5400 rpm 634250-001
e 640 GB, 5400 rpm 669300-001
e 500 GB, 7200 rpm 634925-001
e 500 GB, 5400 rpm 669299-001
7.0 mm (0.28 in) x 6.35 cm (2.50 in):

e 320 GB, 7200 rpm 634862-001
e 320 GB, 5400 rpm 645193-001
Hard Drive Hardware Kit, (not illustrated) includes: 682745-001

Hard drive bumpers (2)

Hard drive bracket

Hard drive cable

Mass storage devices
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Miscellaneous parts

Component Spare part number

HP Smart AC adapter

e 90 W HP Smart AC adapter with Power Factor Correction (PFC) (for computer models 609940-001
equipped with a graphics subsystem with discrete memory only)

e 65 W HP Smart AC adapter with PFC (for computer models equipped with a graphics 609939-001
subsystem with UMA memory only)

e 90 W HP Smart AC adapter with PFC (for select computer models equipped with a graphics 609947-001
subsystem with discrete memory only)

e 65 W HP Smart AC adapter (for select computer models equipped with a graphics subsystem  609948-001
with UMA memory only)

Power cord (3-pin, black, 1.83 m):

e  For use in Argentina 490371-D01
e  Foruse in Brazil 490371-202
e  Forusein ltaly 490371-061
e  Foruse in North America 490371-001
e  For use in Europe 490371-021
e ForuseinIndia 490371-D61
e  Forusein Japan 490371-291
e  For use in the People's Republic of China 490371-AA1
e  Foruse in South Korea 490371-AD1
e Forusein Taiwan 490371-AB1
e  Foruse in Thailand 490371-201
e  For use in the United Kingdom and Singapore 490371-031
Screw Kit 680566-001

Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (black, 3 in, 1.83 m)

490371-021 Power cord for use in Europe (black, 3 in, 1.83 m)

490371-031 Power cord for use in the United Kingdom and Singapore (black, 3 in, 1.83 m)
490371-061 Power cord for use in Italy (black, 3 in, 1.83 m)

490371-201 Power cord for use in Thailand (black, 3 in, 1.83 m)

490371-202 Power cord for use in Brazil (black, 3 in, 1.83 m)

490371-291 Power cord for use in Japan (black, 3 in, 1.83 m)
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Spare part number

Description

490371-AA1 Power cord for use in the People's Republic of China (black, 3 in, 1.83 m)

490371-AB1 Power cord for use in Taiwan (black, 3 in, 1.83 m)

490371-AD1 Power cord for use in South Korea (black, 3 in, 1.83 m)

490371-D01 Power cord for use in Argentina (black, 3 in, 1.83 m)

490371-D61 Power cord for use in India (black, 3 in, 1.83 m)

593553-001 6 cell, 47 Whr, 2.20 Ah Li-ion battery

593554-001 6 cell, 55 Whr, 2.55 Ah Li-ion battery (select models only)

600370-001 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination adapter
(select models only)

609939-001 65 W HP Smart AC adapter with PFC (for computer models equipped with a graphics
subsystem with UMA memory only)

609940-001 90 W HP Smart AC adapter with PFC (for computer models equipped with a graphics
subsystem with discrete memory only)

609947-001 90 W HP Smart AC adapter with PFC (for select computer models equipped with a graphics
subsystem with discrete memory only)

609948-001 65 W HP Smart AC adapter (for select computer models equipped with a graphics subsystem
with UMA memory only)

645193-001 320 GB, 5400 rpm hard drive (7.0 mm (0.28 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

633252-001 750 GB, 7200 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

634250-001 750 GB, 5400 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

634862-001 320 GB, 7200 rpm hard drive (7.0 mm (0.28 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

634925-001 500 GB, 7200 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

637193-001 RTC battery (includes cable and double-sided tape)

641369-001 4 GB memory module (DDR3, 10600, 1333 MHz)

652972-001 2 GB memory module (DDR3, 10600, 1333 MHz)

653339-001 Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W;
includes replacement thermal material)

653340-001 Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W;
includes replacement thermal material)

655795-001 Atheros 9485GN 802.11b/g/n 1x1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select
models only)

656120-001 Ralink RT5390BC8 802.11b/g/n 1x1 WiFi and Bluetooth 3.0+HS Combo Adapter

657325-001 Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter and 20702 Bluetooth 4.0+HS Combo
Adapter

664662-001 Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W;

includes replacement thermal material)
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Spare part number

Description

669299-001 500 GB, 5400 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

669300-001 640 GB, 5400 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

670290-001 Intel Centrino Wireless-N 2230 802.11b/g/n 2x2 WiFi and Bluetooth Combo Adapter

670691-001 Ralink RT5390F 802.11b/g/n 1x1 WiFi Adapter

675794-001 Atheros HB125 802.11b/g/n 1x1 WiFi Adapter (select models only)

676359-001 Intel Core i5-2450M processor (2.50 GHz, turbo up to 3.10 GHz; 1333 MHz/3.0 MB L3 cache,
dual core, 35 W; includes replacement thermal material)

676521-001 1 TB, 5400 rpm hard drive (9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA, does not include hard
drive bumpers, bracket, or cable)

680539-001 Antenna kit (includes left and right wireless antenna cables and transceivers)

680541-001 Display enclosure, Ruby Red

680542-001 Display enclosure, Winter Blue

680543-001 Display enclosure, Sparkling Black

680544-001 Base enclosure

680545-001 Display bezel

680546-001 Optical drive cable (includes optical drive connector)

680547-001 Display Panel Cable Kit (includes display panel cable and webcam/microphone module cable)

680548-001 Power connector cable

680549-001 Heat sink for use only with computer models equipped with a graphics subsystem with
UMA video memory (includes replacement thermal material)

680550-001 Heat sink for use only with computer models equipped with a graphics subsystem with
discrete video memory (includes replacement thermal material)

680551-001 Fan

680553-001 Display hinge covers (2)

680554-001 Display Hinge Kit (includes left and right display hinges and brackets)

680555-001 Keyboard with black finish for use in the United States (includes cable)

680555-161 Keyboard with black finish for use in Latin America (includes cable)

680555-201 Keyboard with black finish for use in Brazil (includes cable)

680555-281 Keyboard with black finish for use in Thailand (includes cable)

680555-291 Keyboard with black finish for use in Japan (includes cable)

680555-AB1 Keyboard with black finish for use in Taiwan (includes cable)

680555-AD1 Keyboard with black finish for use in South Korea (includes cable)

680555-D61 Keyboard with black finish for use in India (includes cable)

680555-DB1 Keyboard with black finish for use in Canada (includes cable)

680556-001 DVD+RW Super Multi Double-Layer Combo Drive (includes bezel and bracket)

22 Chapter 3 lllustrated parts catalog



Spare part number

Description

680557-001 Blu-ray ROM DVD+R/RW Super Multi Double-Layer Drive (includes bezel and bracket)

680558-001 USB board (includes cable)

680559-001 TouchPad button board (includes cable)

680560-001 Power button board (includes cable)

680561-001 Plastics Kit (includes service door)

680562-001 35.6 cm (14.0 in), HD, LED, BrightView display panel

680563-001 Rubber Feet Kit (includes 4 rubber feet)

680565-001 Display Screw Kit

680566-001 Screw Kit

680567-001 Speaker Kit (includes left and right speakers and cable)

680568-001 System board for use only with computer models equipped with UMA video memory (includes
replacement thermal material)

680569-001 System board for use only with computer models equipped with a graphics subsystem with
1024 MB of discrete video memory (includes replacement thermal material)

680570-001 System board for use only with computer models equipped with a graphics subsystem with
2048 MB of discrete video memory (includes replacement thermal material)

680571-001 Thermal Material Kit (includes replacement thermal paste and pads)

680574-001 Top cover, Ruby Red (includes TouchPad)

680575-001 Top cover, Winter Blue (includes TouchPad)

680576-001 Top cover, Sparkling Black (includes TouchPad)

680577-001 Webcam/microphone module

682745-001 Hard Drive Hardware Kit (includes hard drive bracket and bracket screws, cable, and 2
bumpers)

683843-001 PCH heat sink

683845-001 35.6 cm (14.0 in), HD, LED, BrightView display assembly, Ruby Red (includes webcam,
microphone, wireless antenna transceivers and cable, and display cable)

683846-001 35.6 cm (14.0 in), HD, LED, BrightView display assembly, Winter Blue (includes webcam,
microphone, wireless antenna transceivers and cable, and display cable)

683847-001 35.6 cm (14.0 in), HD, LED, BrightView display assembly, Sparkling Black (includes webcam,
microphone, wireless antenna transceivers and cable, and display cable)

683848-001 TouchPad LED board (includes cable)

684479-161 Keyboard with white finish for use in Latin America

684479-201 Keyboard with white finish for use in Brazil

Sequential part number listing
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

=7 NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Cables and connectors

ACAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.
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Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

ACAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

/\ CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm £10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

e When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

e  Nonconductive foam

e Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e  Metal tote boxes

e  Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 63 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw and screw lock size and location during removal
and replacement.
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Service label

When ordering parts or requesting information, provide the computer serial number and model
number provided on the service label.

np Serial: J0CCOC00C (NI INANRRIIWEWIN

- Product: 000000CC (IMNNNNNENIEENNIN
— Warranty: 1ylyOy
Madel: J000000(

N

Item Description Function
1) Product name The name affixed to the front of the computer.
(2) Serial number (s/n) This is an alphanumeric identifier that is unique to

each product.

(3) Part number/Product number (p/n) This number provides specific information about
the product's hardware components. The part
number helps a service technician to determine
what components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description (select models only) This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.
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Computer feet

Description Spare part number

Rubber feet kit 680563-001

The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to
the base enclosure in the locations illustrated below.
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Battery

Description Spare part number
6-cell, 55-Whr, 2.55-Ah Li-ion battery 593554-001
6-cell, 47-Whr, 2.20-Ah Li-ion battery 593553-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Slide the battery release latch (1) to release the battery.
2. Pivot the front edge of the battery (2) up and back.

3.  Remove the battery (3) from the computer.

To insert the battery:

1. Align the tabs on the rear edge of the battery (1) with the notches on the rear edge of the battery
bay.

2. Pivot the front edge of the battery (2) down into the battery bay until it is seated. (The battery
release latch will automatically lock into place.)
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Service door

Description Spare part number

Plastics Kit (contains the service door) 680561-001

Before removing the service door, remove the battery (see Battery on page 31).

1.  Using a small Phillips screwdriver, loosen the service door screw (1).
2. Slide the service door (2) forward slightly and lift the front right corner (3) to tilt the service door.

3.  Remove the service door (4) at an angle.

Reverse this procedure to replace the service door.
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Optical drive

E%?NOTE: The optical drive spare part kit includes a bezel and bracket.

Description Spare part number
Blu-ray ROM DVD+R/RW Super Multi Double-Layer Drive 680557-001
DVD+RW and CD-RW Super Multi Double-Layer Combo Drive 680556-001

Before removing the optical drive, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive:

1.

Using a small Phillips screwdriver, remove the Phillips M2.5 x 6.5 screw (1) that secures the
optical drive to the computer.

Insert a screwdriver or other narrow tool through the release access hole (2) in the bottom of the
computer. Push the rear of the optical drive until it is released.
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3. Pull the optical drive (3) out from the front until the optical drive is completely removed from the
computer.

4. Remove the two Phillips M2.0 x 3.0 screws (1) that secure the optical drive bracket to the optical
drive and then remove the bracket (2) from the optical drive.
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5. Insert a straightened paper clip (1) into the release access opening in the bezel.
6. Press the release tab (2) and remove the bezel from the tab side (3).

7. Remove the bezel (4) from the optical drive.

Reverse this procedure to reassemble and install the optical drive.
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Hard drive

=?NOTE: If your replacement hard drive was shipped without an operating system installed, you will
need to install it using the system recovery discs. See Installing a hard drive without an operating
system on page 38.

If your replacement hard drive shipped with an operating system (image) installed, system recovery
discs are not required for setup. See Installing a hard drive with an operating system on page 37.

@NOTE: The hard drive spare part kit does not include the hard drive cable, hard drive bumpers, or
hard drive bracket and screws.

Description Spare part number

9.5 mm (0.37 in) x 6.35 cm (2.50 in) SATA

1TB, 5400 rpm 676521-001
750 GB, 7200 rpm 633252-001
750 GB, 5400 rpm 634250-001
640 GB, 5400 rpm 669300-001
500 GB, 7200 rpm 634925-001
500 GB, 5400 rpm 669299-001

7.0 mm (0.28 in) x 6.35 cm (2.50 in) SATA

320 GB, 7200 rpm 634862-001

320 GB, 5400 rpm 645193-001

Hard drive hardware kit (includes hard drive cable, hard drive bumpers, and hard drive bracket 682745-001
and screws)

Before removing the hard drive, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the hard drive:

1.

Disconnect the hard drive cable (1) from the computer.
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2. Lift the hard drive (2) to remove.

3. Disconnect the hard drive cable (1). Remove the front bumper (2) and back bumper (3).

4. Remove the four Phillips M3.0x3.5 screws (4), and then remove the bracket (5) from the hard
drive.

Replacing a hard drive

To install a hard drive, reverse the removal procedure.

Installing a hard drive with an operating system

If your hard drive shipped with an operating system (image) installed, system recovery discs are not
required for setup. Turn on the computer and allow the initial setup process to set up the operating

system completely.

E'/’oIMPORTANT: Do not turn off the computer during the initial setup process. Allow the setup process
to complete to ensure that everything that is necessary to operate the computer is installed properly.
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After the setup has been completed, reinstall any applications and restore any data that you backed
up.

If you need further assistance, call 1-800-474-6836 (1 800-HP Invent).

Installing a hard drive without an operating system

@NOTE: If your hard drive was shipped without an operating system installed, you will need to

reinstall it using the system recovery discs. To install the operating system, refer to the instructions
included with your system recovery discs or that are available from the support site
(http://www.hp.com/go/contactHP).

@IMPORTANT: Do not turn off the computer during the initial setup process. Allow the system
recovery process to complete to ensure that everything that is necessary to operate the computer is
installed properly.

The system recovery process takes approximately 3 hours to complete. When the system recovery is
complete, the computer reboots and the Windows Setup screen displays. After the operating system
has been installed, reinstall any applications and restore any data that you backed up.

If you need further assistance, call 1-800-474-6836 (1 800-HP Invent).

Memory module

AWARNING! To reduce the risk of electric shock and damage to the equipment, unplug the power
cord and remove all batteries before installing a memory module.

/\ CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning
any procedure, ensure that you are discharged of static electricity by touching a grounded metal
object.

E/?’NOTE: To use a dual-channel configuration with a second memory module, be sure that both
memory modules are identical.

Description Spare part number
4 GB (PC3, 12800, 1600 MHz) 641369-001
2 GB (PC3, 12800, 1600 MHz) 652972-001

Before removing a memory module, follow these steps:

/\ CAUTION: To prevent information loss or an unresponsive system, shut down the computer before
adding or replacing memory modules. Do not remove a memory module while the computer is on, in
the Sleep state, or in Hibernation.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the service door (see Service door on page 32).
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To add or replace a memory module:

1. Spread the retention clips (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

ACAUTION: To prevent damage to the memory module, hold the memory module by the edges
only. Do not touch the components on the memory module.

/\ CAUTION: To protect a memory module after removal, place it in an electrostatic-safe
container.

3. Align the notched edge (1) of the memory module with the tab in the memory module slot.

4. With the memory module at a 45-degree angle from the surface of the memory module
compartment, press the module into the memory module slot (2) until it is seated.
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5. Gently press the memory module (3) down, applying pressure to both the left and right edges of
the module, until the retention clips snap into place.
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WLAN module

Description Spare part number
Atheros 9485GN 802.11b/g/n 1x1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select 655795-001

models only)

Atheros HB125 802.11b/g/n 1x1 WiFi Adapter (select models only) 675794-001
Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination adapter (select = 600370-001

models only)

Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter and 20702 Bluetooth 4.0+HS Combo Adapter 657325-001

Intel Centrino Wireless-N 2230 802.11b/g/n 2x2 WiFi and Bluetooth Combo Adapter 670290-001

Ralink RT5390BC8 802.11b/g/n 1x1 WiFi and Bluetooth 3.0+HS Combo Adapter 656120-001

Ralink RT5390F 802.11b/g/n 1x1 WiFi Adapter 670691-001

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5.  Remove the service door (see Service door on page 32).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

2% NOTE: The 1/black WLAN antenna cable is connected to the WLAN module 1/Main terminal.

— The 2/gray WLAN antenna cable is connected to the WLAN module 2/Aux terminal.

2. Remove the Phillips M2.5%2.5 screw (2) that secures the WLAN module to the system board.

(The WLAN module tilts up.)
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3.  Remove the WLAN module by pulling the module away from the slot at an angle (3).

E%NOTE: The WLAN module is designed with a notch to prevent incorrect installation into
the WLAN module socket.

o1

Reverse this procedure to install the WLAN module.

42 Chapter 4 Removal and replacement procedures



Keyboard

E%?NOTE: The keyboard spare part kit includes a keyboard cable.

Description Spare part number

Black keyboard

For use in Brazil 680555-201
For use in Canada 680555-DB1
For use in India 680555-D61
For use in Japan 680555-291
For use in Latin America 680555-161
For use in South Korea 680555-AD1
For use in Taiwan 680555-AB1
For use in Thailand 680555-281
For use in the United States 680555-001

White keyboard

For use in Brazil 684479-201

For use in Latin America 684479-161

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

il

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

N o g A

Remove the hard drive (see Hard drive on page 36).

Component replacement procedures 43



Remove the keyboard:

1. Remove the Phillips M2.5x6.5 screw that secures the keyboard to the computer.

2. Turn the computer right-side up with the front toward you and open the display.

3. Stand the computer on its left side.

4. Insert a finger or thin tool into the optical drive bay, and then press on the back of the keyboard
until the keyboard disengages from the computer.

19,
MNOTE: The keyboard icon in the optical drive bay

5. Turn the computer right-side up with the front toward you.
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6. Lift the rear edge (1) of the keyboard , and then move the keyboard (2) toward the display panel.

7. Tilt the keyboard forward (1) onto the palm rest. Release the zero insertion force (ZIF) connector
(2) to which the keyboard cable is attached, and then disconnect the keyboard cable (3) from
the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

@NOT

E: The top cover spare part kit includes the TouchPad.

Description Spare part number
Ruby Red 680574-001
Sparkling Black 680576-001
Winter Blue 680575-001

Before removing the top cover, follow these steps:

1.

g

4
5
6.
7
8

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

When replacing the top cover, be sure that the following components are removed from the defective

top ¢
o
o

over and installed on the replacement top cover:

Power button board and cable (see Power button board on page 50).

TouchPad button board and cable (see TouchPad button board on page 51).

TouchPad LED board and cable (see TouchPad LED board on page 52).

Speakers and cable (see Speakers on page 49).
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Remove the top cover:

1. Disconnect these cables from the system board:
(1) Power button board ZIF cable
(2) Speaker cable
(3) TouchPad button board ZIF cable

2. Remove the following screws under the keyboard:
(1) Three Phillips M2.5 x 3.0
(2) Three Phillips M2.5 x 6.5

3. Close the computer.

4. Turn the computer upside down, with the front toward you.
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5. Remove the following screws that secure the top cover to the computer:
(1) Two Phillips M2.5x 7.5
(2) Five Phillips M2.5 x 6.5

6. Turn the computer right-side up, with the front toward you.
7. Open the computer.

8. Lift the front edge of the top cover (1) until the left and right sides disengage from
the base enclosure.

9. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Speakers

Description Spare part number

Speaker Kit (includes left and right speakers and cable) 680567-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

d

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

4
5
6. Remove the optical drive (see Optical drive on page 33).
7
8
9

Remove the top cover (see Top cover on page 46).

Remove the speakers:

1. Remove the Phillips M2.5 x 4 screw (1) from the left speaker and the Phillips M2.5 x 3 screw (1)
from the right speaker.

2. Release the speaker cable from the clips built into the top cover (2).

3. Lift the speakers from the top cover.

Reverse this procedure to install the speakers.
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Power button board

Description Spare part number

Power button board (includes cable) 680560-001

Before removing the power button board, follow these steps:

1.

w
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10.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the speakers (see Speakers on page 49).

Remove the power button board:

1.
2,
3.

Turn the top cover upside down, with the front toward you.
Remove the Phillips M2.5 x 2.5 screw (1) that secures the power button board to the top cover.

Remove the power button board and cable (2).

o—5
|

Reverse this procedure to install the power button board.
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TouchPad button board

Description Spare part number

TouchPad button board (includes cable) 680559-001

Before removing the TouchPad button board, follow these steps:

1.

d

4
5
6.
7
8
9

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the TouchPad button board and cable:

1.
2,

Turn the top cover upside down, with the front toward you.

Release the ZIF connector to which the TouchPad button board cable is connected, and then
disconnect the TouchPad button board cable (1) from the back of the TouchPad.

Remove the Phillips M2.5 x 2.5 screw (2) that secures the TouchPad button board cable to
the top cover.

Lift the front edge of the TouchPad button board (3) until it is released from the clips built into
the top cover.
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5. Lift the TouchPad button board (4) slightly to perform the next step.

6. Carefully invert the TouchPad button board (1).

7. Release the ZIF connector to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (2) from the TouchPad button board.

8. Lift the TouchPad button board away from the top cover (3).

Reverse this procedure to install the TouchPad button board and cable.

TouchPad LED board

Description Spare part number

TouchPad LED board (includes cable) 683848-001
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Before removing the TouchPad LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

il

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

© ©® N o a &

Remove the top cover (see Top cover on page 46).

10. Remove the TouchPad button board (see TouchPad button board on page 51).

Remove the TouchPad LED board and cable:

1. Turn the top cover upside down, with the front toward you.

2.  Apply slight pressure to the retaining clips (1) of the top cover.

3. Lift the TouchPad LED board on the right front corner (2) up and away from the top cover.

4. Remove the TouchPad LED board and cable.

Reverse this procedure to install the TouchPad LED board and cable.
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Display assembly

@NOTE: The display assembly spare part kit includes webcam, two microphones, and wireless
antenna transceivers and cables.

Description Spare part number

35.6 cm (14.0 in), HD, LED, BrightView display assembly

e RubyRed 683845-001
e  Sparkling Black 683847-001
e  Winter Blue 683846-001
Display Screw Kit 680565-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

d

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

4
5
6. Remove the optical drive (see Optical drive on page 33).
7
8
9

Remove the top cover (see Top cover on page 46).

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.
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2,

Release the wireless antenna cables (2) from the clips and the opening in the base enclosure.

= NOTE: It may be necessary to release the USB board ZIF cable to remove the wireless
antenna cables.

/\ CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

Remove the four Phillips M2.5 x 6.5 screws (1) that secure the display assembly to
the computer.

Remove the display assembly by lifting straight up (2).
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5. Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the plastic screw covers (1) and the two Phillips M2.5 x 3.5 screws (2) that secure
the display bezel to the display assembly.

b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (4). The display bezel is available using spare part number
680545-001.

6. Ifitis necessary to replace the webcam/microphone module:

a. Detach and release the webcam/microphone module (1) as far as the webcam/microphone
module cable allows. (The webcam/microphone module is attached to the display
enclosure with double-sided tape.)
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b. Disconnect the webcam/microphone cable (2) from the webcam/microphone module.

c. Remove the webcam/microphone module. The webcam/microphone module is available
using spare part number 680577-001.

7. Ifitis necessary to replace the hinge covers, to remove the display cable, or to remove the
antenna cables:

a. The hinge covers are held in place by the same screws as the previously removed bezel.

b. Using a small tool to pry, remove the hinge covers. The hinge covers are available using
spare part number 680553-001.
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8. Ifitis necessary to replace the display panel:

a. Remove the four bottom Phillips M2.5 x 3.5 screws and the two top Phillips M2.5 x 2.5
screws that secure the display panel to the display enclosure.

b. Lift the top edge of the display enclosure, (1) and then swing it up and forward until it is
perpendicular to the display panel.
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c. Release the adhesive strip (2) that secures the display panel cable to the display panel,
and then disconnect the display panel cable (3) from the display panel.

d. Remove the display panel. The display panel cable is available using spare part number
680547-001.

9. Ifitis necessary to replace the display hinges:

a. Remove the four Phillips M2.0 x 3.0 screws (1) that secure the display hinges to
the display panel.
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b. Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 680554-001.

10. Ifitis necessary to replace the display panel cable:

a. Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

b. Release the display panel cable from the clips (2) built into the display enclosure.

c. Remove the display panel cable. The display panel cable includes the webcam/microphone
module cable and is available in the Display Panel Cable Kit, spare part number
680547-001.
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11. Ifitis necessary to replace the wireless antenna cables and transceivers:
a. Release the wireless antenna cables from the clips (1) built into the display enclosure.

b. Release the wireless antenna transceivers (2) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

c. Remove the wireless antenna cables and transceivers. The wireless antenna cables and
transceivers are available in the Antenna Kit, spare part number 680539-001.

)

The display panel is available using spare part number 680562-001.

Reverse this procedure to reassemble and install the display assembly.

Optical drive cable

E’%NOTE: The optical drive cable is included in the Cable Kit, spare part number 680546-001. The
optical drive cable includes the optical drive connector.

Before removing the optical drive cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

4

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31.

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).
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Remove the top cover (see Top cover on page 46).
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Remove the optical drive cable:
1. Disconnect the optical drive cable (1) from the system board .
2. Release the optical drive cable (2) from the clips built into the base enclosure.

3. Release the optical drive connector from the base enclosure by prying the clips (3) that secure
the optical drive connector to the base enclosure.

4. Remove the optical drive cable from the base enclosure (4).

Reverse this procedure to install the optical drive cable.
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USB board

Description Spare part number

USB board (includes cable) 680558-001

Before removing the USB board, follow these steps:

1.

d
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Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the USB board:

1.

If not released already, release the ZIF connector (1) to which the USB board cable is
connected, and then disconnect the USB board cable from the system board.

Pry the clip (2) that secures the USB board to the base enclosure.

Remove the USB board and cable by lifting straight up (3).

Reverse this procedure to install the USB board.
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Power connector cable

Description Spare part number

Power connector cable 680548-001

Before removing the power connector cable, follow these steps:

1.

w
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Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the power connector cable:

1.
2,

Disconnect the power connector cable (1) from the system board.

Remove the power connector from the base enclosure (2).

Reverse this procedure to install the power connector cable.
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System board

E%?NOTE: The system board thermal pad kit, part number 680571-001,
includes replacement thermal material.

Description Spare part number

For use only with computer models equipped with UMA video memory 680568-001

For use only with computer models equipped with 2048 MB of dedicated discrete video memory 680570-001

For use only with computer models equipped with 1024 MB of dedicated discrete video memory 680569-001

Before removing the system board, follow these steps:

1.

w
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9.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

Memory module (see Memory module on page 38)

RTC battery (see RTC battery on page 67)

Fan and heat sink (see Fan and heat sink on page 68).

PCH heat sink (see PCH heat sink on page 71)

Processor (see Processor on page 72)
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Remove the system board:

1. Disconnect the following cables from the system board:
(1) Display panel cable
(2) optical drive cable

(3) USB board cable

(4) Power connector cable

2. Remove the Phillips M2.5 x 4.5 screw (1) that secures the system board to the base enclosure.
3. Lift the right side of the system board (2) until it rests at an angle.
4. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 637193-001

Before removing the RTC battery, follow these steps:

1.

d
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10.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the system board (see System board on page 65).

Remove the RTC battery:

1.
2.
3.

Turn the system board upside down, with the front toward you.

Disconnect the RTC battery cable (1) from the system board.

Remove the RTC battery (2) from the system board. (The RTC battery is attached to the system

board with double-sided tape.)

’ 4 : = o

Reverse this procedure to install the RTC battery.
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Fan and heat sink

@NOTE: The fan and heat sink spare part kits include replacement thermal material.

Description Spare part number
Fan 680551-001
Heat sink for use only with computer models equipped with UMA video memory 680549-001
Heat sink for use only with computer models equipped with discrete video memory 680550-001

@NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan and heat sink, follow these steps:

1.

w
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10.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the system board (see System board on page 65).

Remove the fan and heat sink:

1.
2.

Turn the system board upside down, with the front toward you.

Disconnect the fan cable (1) from the system board.

/\ CAUTION: To prevent damage to heat sinks and/or processors, loosen/tighten captive screws

in sequence as numerically labeled.

E’%NOTE: The heat sink and fan appearance and the number of screws may be different from the

3.

heat sink and fan pictured.

Loosen the four captive screws (2) and the three captive screws (3) that secure the heat sink to

the system board.

E%?NOTE: Due to the adhesive quality of the thermal material located between the heat sink and

system board components, it may be necessary to move the heat sink from side to side to
detach it.
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4. Remove the fan and heat sink (4).

@NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the base enclosure, heat sink, processor, and system board
spare part kits.

e Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e Athermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with
discrete memory)

1. Ifitis necessary to replace the fan, turn the fan and heat sink upside down with the fan
toward you.

2. Remove the two Phillips M1.5 x 2.5 screws (1) that secure the fan to the heat sink.
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3. Disengage the two clips that secure the fan to the heat sink and remove the heat sink (2) from
the fan.

Reverse this procedure to reassemble and install the fan and heat sink.
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PCH heat sink

Description Spare part number

PCH heat sink 683843-001

Before removing the PCH heat sink, follow these steps:

1.

d

4
5
6.
7
8
9

10.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

Remove the top cover (see Top cover on page 46).

Remove the system board (see System board on page 65).

Remove the PCH heat sink:

1.

Remove the two Phillips M2.0 x 3.0 screws (1) that secure the PCH heat sink to the system
board.
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2. Remove the PCH heat sink by lifting straight up (2).

E%NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.

r__*:"/?NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the base enclosure, heat sink, processor, and system board
spare part kits.

Reverse this procedure to install the PCH heat sink.

Processor

%/%"NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Core i5-2450M processor (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/3.0 MB L3 cache, 676359-001
dual core, 35 W)

Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W) 653340-001
Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W) 653339-001
Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W) 664662-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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Remove the battery (see Battery on page 31).

Remove the service door (see Service door on page 32).

Remove the optical drive (see Optical drive on page 33).

Remove the hard drive (see Hard drive on page 36).

Remove the keyboard (see Keyboard on page 43).

© ® N o a A

Remove the top cover (see Top cover on page 46).

10. Remove the system board (see System board on page 65).

11. Remove the heat sink (see Fan and heat sink on page 68).

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

’@?NOTE: The gold triangle on the processor (3) must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup
Utility includes settings for the types of peripherals installed, the startup sequence of the computer,
and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer
from operating properly.

Starting Setup Utility

@NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only
if USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

Changing the language of Setup Utility
Start Setup Utility.

Use the arrow keys to select System Configuration > Language, and then press enter.

1

2

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.
5

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1.

2,

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of
the screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Setup Utility.

Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information

1.
2.

Start Setup Utility.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

@NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press f10 to enter Setup Utility.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o & 0 BN

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

=7 NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility
e To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Saving Changes, and then press enter.

e  To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using
the AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During
the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. Atthe download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

E/f’NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after
the download is complete. If no instructions are displayed, follow these steps:

1.  Open Windows Explorer by selecting Start > Computer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.
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4. Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete
the downloaded file from your hard drive.

Using System Diagnostics

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start
the computer.

e Run-in test—This test repeats the start-up test and checks for intermittent problems that
the start-up test does not detect.

e Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

e Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact
HP support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.
To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

@NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions:
Width 347 cm 13.67 in
Depth 23.1cm 9.10in
Height (front to back) 3.0cmto 3.6 cm 1.9into1.4in
Weight: 2.20 kg 4.9 Ibs
Input power

Operating voltage and current

185Vdc@3.5A0r19.5V dc @ 3.33 A— 65 W
19V dc@4.74 Aor19.5V dc @ 4.62 A— 90 W

Temperature
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 90%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)

-15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15mto0 12,192 m -50 ft to 40,000 ft

Shock

Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within

this range of temperatures.

Computer specifications
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35.6 cm (14.0 in), display specifications

Metric uU.s.
Dimensions
Width 31.2cm 12.28in
Height 17.6 cm 6.93 in
Diagonal 35.7cm 14.05 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness 200 cd/m? (nits) (typical)
Backlight LED

Character display 80 x 25

Total power consumption 6.0 W

Viewing angle

+/-65 horizontal, +/-50° vertical (typical)

Hard drive specifications

1TB* 750 GB* 640 GB* 500 GB* 320 GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 7.0 mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 107 g max 107 g max 107 g max 107 g max 107 g max
Interface type SATA SATA SATA SATA SATA
Transfer rate 300 MB/sec 300 MB/sec 300 MB/sec 300 MB/sec 300 MB/sec
Security ATA security ~ ATA security =~ ATA security  ATA security ATA security
Seek times (typical read, including setting)
Single track 1.5ms 1.0 ms 1.0 ms 1.5 ms 20ms
Average 11.0 ms 14.0 ms 14.0 ms 120 ms 120 ms
Maximum 22.0ms 24.0ms 22.0ms 22.0ms 22.0ms
Logical blocks 1,953,525,168 1,465,128,359 1,250,242,867 976,752,240 625,121.433
Disk rotational speed 5400 rpm 7200 and 5400 rpm 7200 and 7200 and

5400 rpm 5400 rpm 5400 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*Size refers to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact support for details.
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DVD*RW SuperMulti Double-Layer Combo Drive
specifications

Applicable disc

Read

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-l, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write

CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time

DVD <230 ms
CD <175 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode

DVDxRW SuperMulti Double-Layer Combo Drive specifications
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BD ROM DVD*R/RW Super Multi Double-Layer Drive
specifications

Applicable disc

Read

BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write

DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time

BD <230 ms
DVD <180 ms
CD <180 ms
Cache buffer 4.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
4X BD 18,000 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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7 Backing up, restoring, and recovering

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and retrieve it if ever needed.

Creating backups

1.

Use HP Recovery Manager to create recovery media immediately after you set up the working
computer.

As you add hardware and software programs, create system restore points.

As you add photos, video, music, and other personal files, create a backup of your system and
personal information.

Creating recovery media to recover the original system

After you successfully set up the computer, you should create recovery discs or a recovery flash drive
using HP Recovery Manager. You will need these recovery discs or recovery flash drive to perform a
system recovery should the hard drive become corrupted. A system recovery reinstalls the original
operating system, and then configures the settings for the default programs.

What you need to know

Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

HP Recovery Manager examines the computer and determines the required storage capacity for
the flash drive or the number of blank DVD discs that will be required.

Use DVD-R, DVD+R, DVD-R DL, DVD+R DL discs or a flash drive. Do not use rewriteable discs
such as CD+RW, DVD+RW, double-layer DVD+RW, and BD-RE (rewritable Blu-ray) discs; they
are not compatible with HP Recovery Manager software.

If your computer does not include an integrated optical drive, you can use an optional external
optical drive (purchased separately) to create recovery discs, or you can obtain recovery discs
for your computer from the HP website. If you use an external optical drive, it must be connected
directly to a USB port on the computer, not to a USB port on an external device, such as a USB
hub.

Be sure that the computer is connected to AC power before you begin creating the recovery
media.

The creation process can take up to an hour or more. Do not interrupt the creation process.
Store the recovery media in a safe location, separate from the computer.

If necessary, you can exit the program before you have finished creating the recovery media.
The next time you open HP Recovery Manager, you will be prompted to continue the process.

Creating backups
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Creating the recovery media

1. Select Start and type recovery in the search field. Select Recovery Manager from the list.
Allow the action to continue, if prompted.

2. Click Recovery Media Creation.
3. Follow the on-screen instructions to continue.

To recover, see Recovering the original system using HP Recovery Manager on page 86

Creating system restore points

A system restore point is a snapshot of certain hard drive contents saved by Windows System
Restore at a specific time. A restore point contains information such as registry settings that Windows
uses. Restoring to a previous restore point allows you to reverse changes that have been made to the
system since the restore point was created.

Restoring to an earlier system restore point does not affect data files saved or emails created since
the last restore point, but it does affect software you may have installed.

For example, if you download a photo from a digital camera and then restore the computer to the
state it was on the previous day, the photo remains on the computer.

However, if you install photo viewing software and then restore your computer to the state it was on
the previous day, the software will be uninstalled, and you won't be able to use it.

What you need to know

e If you restore to a restore point and then change your mind, you can undo the restoration.
e  You should create system restore points:

° Before you add or change software or hardware

° Periodically, whenever the computer is running normally

e System Restore also saves shadow copies of files that have been changed since the last restore
point was created. For more information about using shadow copies to restore, see Help and
Support.

Creating a system restore point

1. Select Start > Control Panel > System and Security > System.
2. Inthe left pane, click System Protection.

3. Click the System Protection tab.

4. Click Create, and follow the on-screen instructions.

To restore, see Restoring to a previous system restore point on page 86.

Backing up system and personal information
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Your computer stores information that is important to you, such as files, emails, and photos, and you
will want to keep that information even if you download a virus or the system stops working properly.
How completely you are able to recover your files depends on how recent your backup is. As you add
new software and data files, you should create backups on a regular basis.
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Tips for a successful backup

Number backup discs before inserting them into the optical drive.

Store personal files in the Documents, Music, Pictures, and Videos libraries, and back up these
folders periodically.

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1.
2.

4,

Display the screen you want to save.

Copy the screen image:

To copy only the active window, press alt+prt sc.
To copy the entire screen, press prt sc.

Open a word-processing document or graphics editing program, and then select Edit > Paste.
The screen image is added to the document.

Save and print the document.

What you need to know

You can back up your information to an optional external hard drive, a flash drive, a network
drive, or discs.

Connect the computer to AC power during backups.

Allow enough time for the backup. Depending on files sizes, it may take more than an hour.
Verify the amount of free space on your backup storage device before you back up.

You should back up:

° Before adding or changing software or hardware.

° Before the computer is repaired or restored.

° On a regular schedule to be sure you have recent copies of personal information.

° After you add many files—for example, if you saved videos from a birthday party.

° Before using antivirus software to remove a malicious program.

° After adding information that is hard to replace, such as pictures, videos, music, project
files, or data records.

Creating a backup using Windows Backup and Restore

Windows allows you to back up files using Windows Backup and Restore. You can select the level
you want to back up, from individual folders to drives. The backups are compressed to save space.
To back up:

1.
2.

Select Start > Control Panel > System and Security > Backup and Restore.

Follow the on-screen instructions to schedule and create a backup.

=»NOTE: Windows includes the User Account Control feature to improve the security of the computer.

You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.

Creating backups
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To restore, see Restoring specific files using Windows Backup and Restore on page 86.

Restore and recovery

Restoring to a previous system restore point

Sometimes installing a software program causes your computer or Windows to behave unpredictably.
Usually uninstalling the software fixes the problems. If uninstalling does not fix the problems, you can
restore the computer to a previous system restore point (created at an earlier date and time).

To restore to a previous system restore point, when the computer was running correctly:
1. Select Start > Control Panel > System and Security > System.

2. Inthe left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore, and follow the on-screen instructions.

Restoring specific files

If files are accidentally deleted from the hard disk and they can no longer be restored from the
Recycle Bin, or if files become corrupt, restoring specific files is useful. Restoring specific files is also
useful if you ever choose to recover the original system using HP Recovery Manager. You can only
restore specific files that you have backed up before.

Restoring specific files using Windows Backup and Restore
Windows allows you to restore files that were backed up using Windows Backup and Restore:
1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to restore your backup.

@NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.

Recovering the original system using HP Recovery Manager

HP Recovery Manager software allows you to repair or recover the computer to its original factory
state.

What you need to know

e HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's
website or reinstall the software from the disc provided by the manufacturer.

e A system recovery should be used as a final attempt to correct computer issues. If you have not
already tried restore points (see Restoring to a previous system restore point on page 86) and
partial restores (see Restoring specific files on page 86), try them before using HP Recovery
Manager to recover your system.

e A system recovery must be performed if the computer hard drive fails or if all attempts to correct
any functional computer issues fail.
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e If the recovery media do not work, you can obtain recovery discs for your system from the HP
website.

e The Minimized Image Recovery option is recommended for advanced users only. All hardware-
related drivers and software are re-installed, but other software applications are not. Do not
interrupt the process until it is complete, otherwise the recovery will fail.

Recovering using HP Recovery partition (select models only)

The HP Recovery partition (select models only), allows you to restore your system without the need
for recovery discs or a recovery flash drive. This type of recovery can only be used if the hard drive is
still working.

To check for the presence of a recovery partition, select Start, right-click Computer then select
Manage > Disk Management. If the recovery partition is present, a Recovery drive is listed in the
window.

E%"%NOTE: Recovery discs have been included if your computer did not ship with a recovery partition.

1. Access HP Recovery Manager in either of the following ways:

e Select Start and type recovery in the search field. Select Recovery Manager from the
list.

e Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then press 11 while the
“F11 (System Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.

Recovering using the recovery media
1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external
optical drive, and then restart the computer.

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

¢ NOTE: If the computer does not automatically restart in HP Recovery Manager, change the
computer boot order. See Changing the computer boot order on page 87.

3. Press 9 at system bootup.
4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order
To change the boot order for recovery discs:
1. Restart the computer.
2. Press esc while the computer is restarting, and then press 9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.
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To change the boot order for a recovery flash drive:

1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press 9 for boot options.
4

Select the flash drive from the boot options window.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 V ac, or from 220 to 240 V ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country and
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region

Accredited agency

Applicable note number

Argentina IRAM 1
Australia SAA 1
Austria OVE 1
Belgium CEBEC 1
Brazil ABNT 1
Canada CSA 2
Chile IMQ 1
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
India ISI 1
Israel Sli 1
Italy IMQ 1
Japan JIS 3
The Netherlands KEMA 1
New Zealand SANZ 1
Norway NEMKO 1
The People's Republic of China CCC 4
Saudi Arabia SASO 7
Singapore PSB 1
South Africa SABS 1
South Korea KTL 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 6
Thailand TISI 1
The United Kingdom ASTA 1
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Country/region Accredited agency Applicable note number

The United States UL 2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75 mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL
mark. UL file number must be on each element.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm? or 1.25 mm? conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75 mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

The flexible cord must be Type HO5VV-F 3-conductor, 0.75 mm? conductor size. KTL logo and individual approval
number must be on each element. Corset approval number and logo must be printed on a flag label.

The flexible cord must be Type HVCTF 3-conductor, 1.25 mm? conductor size. Power cord set fittings (appliance
coupler, cable, and wall plug) must bear the BSMI certification mark.

For 127 V ac, the flexible cord must be Type SVT or SJT 3-conductor, 18 AWG, with plug NEMA 5-15P (15 A, 125V
ac), with UL and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type HO5VV-F 3-conductor, 0.75 mm? or
1.00 mm2 conductor size, with plug BS 1363/A with BSI or ASTA marks.

Requirements for specific countries and regions
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9 Recycling

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for battery disposal. HP
encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For more information about recycling programs, see the HP website at www.hp.com/recycle.
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A
AC adapter 11
AC adapter, spare part numbers
20, 21
action keys
identifying 7
antenna
locations 5
removal 61
spare part number 18, 22, 61
Antenna Kit, spare part number
18, 22, 61
audio, product description 2
audio-in (microphone) jack 10
audio-out (headphone) jack 10

B
backups 83
base enclosure, spare part

number 16, 22
battery
removal 31

spare part numbers 16, 21, 31
battery bay 12
battery release latch 12
Blu-ray Disc (BD) ROM and DVD
+R/RW SuperMulti Double-Layer
Drive
specifications 82
Blu-ray ROM DVD+R/RW Super
Multi Double-Layer Drive
precautions 25
removal 33
spare part numbers
23,33
boot order
changing 87
bottom components 12
button component 6
buttons
left TouchPad 9
optical drive eject 11
power 6
right TouchPad 9
TouchPad on/off 9

17,19,

C
cable kit 61
cables, service considerations 24
caps lock light, identifying 8
chipset, product description 1
components

bottom 12

button 6

display 5

keys 7

left side 10

lights 8

right side 11

TouchPad 9
computer feet

locations 30

spare part number 16, 23, 30
computer major components 14
computer specifications 79
connector, power 11
connectors, service
considerations 24

D
deleted files
restoring 86
Digital Media Slot, identifying 10
display assembly
removal 54
spare part numbers
subcomponents 18
display bezel
removal 56
spare part number
display components 5
display enclosure, spare part
numbers 18
Display Hinge Kit, spare part
number 18, 22, 60
display panel
product description 1
removal 58
spare part number

15, 23, 54

18, 22, 56

18, 23, 61

display panel cable

removal 60
spare part number 18, 22, 59,
60
Display Panel Cable Kit, spare part
number 18, 22, 60

Display Screw Kit, spare part
number 18, 23
display specifications 80
drives, preventing damage 25
DVDzRW and CD-RW Super Multi
Double-Layer Combo Drive
precautions 25
removal 33
spare part numbers 33
DVDzRW and CD-RW SuperMulti
Double-Layer Combo Drive
specifications 81
DVD+RW Super Multi Double-
Layer Combo Drive
spare part numbers 17, 19, 22
E
electrostatic discharge 25
equipment guidelines 28
esc key, identifying 7
Ethernet, product description 2
external media cards, product
description 3
external monitor port 10

F
fan
removal 68
spare part number
feet
locations 30
spare part number
fn key, identifying 7

16, 22, 68

16, 23, 30

G
graphics, product description 1
grounding guidelines 25
guidelines

equipment 28
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grounding 25
packaging 27
transporting 27
workstation 27

H
hard drive
precautions 25
product description 2
removal 36
spare part numbers 16, 19, 36
specifications 80
hard drive bay, identifying 12
hard drive bracket, illustrated 19
hard drive bumper
illustrated 19
Hard Drive Hardware Kit, spare
part number 16, 19, 23, 36
hard drive light 11
HDMI port, identifying 10
heat sink
removal 68
spare part numbers 22, 68
hinge
removal 59
spare part number
hinge cover
removal 57
spare part number 18, 22, 57
HP Recovery Manager 86

18, 22, 60

I
internal media card, product
description 3

J
jack
audio-in (microphone) 10
audio-out (headphone) 10
jacks
network 10
RJ-45 (network) 10

K
key components 7
keyboard
product description 3
removal 43
spare part numbers 15, 22, 43
keys
action 7
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esc 7

fn 7

Operating system
applications 7
operating system logo 7
Windows applications 7
Windows logo 7

L
latch, battery release 12
left-side components 10
light components 8
lights
AC adapter 11
caps lock 8
hard drive 11
mute 8
optical drive 11
power 8, 11
TouchPad 8,9
webcam 5
wireless 8

M
mass storage device
precautions 25
removal 36
spare part numbers
memory module
product description 1
removal 38
spare part numbers 16, 21, 38
memory module compartment,
identifying 12
microphone
location 5
product description 2
model name 1
mute light, identifying 8

19, 36

N
network jack, identifying 10

(0]
Operating system applications key,
identifying 7
operating system logo
identifying 7
operating system, product
description 4

optical drive
precautions 25
product description 2
removal 33
spare part numbers
specifications 81, 82
optical drive bracket, removal 34
optical drive cable
removal 61
optical drive eject button,
identifying 11
optical drive light, identifying 11
optical drive, identifying 11
original system recovery 86

17,19, 33

P
packaging guidelines 27
PCH heat sink
removal 71
spare part number 71
plastic parts, service
considerations 24
plastics kit 32
Plastics Kit, spare part number
17, 23
pointing device, product
description 3
ports
external monitor 10
HDMI 10
UsB2.0 11
UsB3.0 10
ports, product description 3
power button board
removal 50
spare part number 15, 23, 50
power button, identifying 6
power connector cable
removal 64
spare part number 16, 22
power connector, identifying 11
power cord
requirements for all countries
89
requirements for specific
countries and regions 90
set requirements 89
spare part numbers 20, 21
power lights, identifying 8, 11



power requirements, product
description 3
processor
removal 72
spare part numbers 16, 21, 72
processors, product description 1
product description
audio 2
chipset 1
display panel 1
Ethernet 2
external media cards 3
graphics 1
hard drives 2
internal media card 3
keyboard 3
memory module 1
microphone 2
operating system 4
optical drive 2
pointing device 3
ports 3
power requirements 3
processors 1
product name 1
security 4
serviceability 4
video 2
wireless 2
product name 1

R
recovering from the recovery
discs 87
recovering the original system 86
recovery 86
HP Recovery Manager 86
recovery discs 83
recovery media 83
recovery, system 86
recycling 92
removal/replacement
preliminaries 24
procedures 28
restore points 84
restoring the original system
creating recovery media 83
right-side components 11
RJ-45 (network) jack, identifying
10

RTC battery
removal 67
spare part number 16, 21, 67
Rubber Feet Kit, spare part
number 16, 23, 30

S
Screw Kit, spare part number 20,
23
security cable slot, identifying 11
security, product description 4
service considerations
cables 24
connectors 24
plastic parts 24
service door
removal 32
spare part number
service label 13, 29
serviceability, product
description 4
Setup Utility (BIOS) 74
slots
Digital Media 10
security cable 11
Speaker Kit, spare part number
15, 23, 49
speakers
removal 49
spare part number
speakers, identifying 6
specifications
Blu-ray Disc (BD) ROM and
DVD+R/RW SuperMulti
Double-Layer Drive 82
computer 79
display 80
DVD+RW and CD-RW
SuperMulti Double-Layer
Combo Drive 81
hard drive 80
optical drive 81, 82
supported discs 83
system board
removal 65
spare part numbers
System Diagnostics 74
system recovery 86
system restore points 84
creating 84

17, 32

15, 23, 49

15, 23, 65

T
tools required 24
top cover

removal 46

spare part numbers
TouchPad

buttons 9
TouchPad button board

removal 51

spare part number 15, 23, 51
TouchPad components 9
TouchPad LED board

removal 52

spare part number
TouchPad light 9
TouchPad on/off button 9
TouchPad reader light 8
TouchPad zone, identifying 9
transporting guidelines 27

15, 23, 46

15, 23, 52

U
USB 2.0 ports, identifying 11
USB 3.0 ports, identifying 10
USB board
removal 63
spare part number 16, 23
Vv
vents, identifying 10, 12
video, product description 2

w
webcam light 5
webcam, location 5
webcam/microphone module
removal 56
spare part number 18, 23, 57
Windows applications key,
identifying 7
Windows Backup and Restore
restoring files 86
Windows logo key, identifying 7
wireless antenna
locations 5
removal 61
spare part number
wireless light 8
wireless module compartment,
identifying 12
wireless, product description 2

18, 22, 61
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WLAN module

removal 41
spare part numbers 17, 21,
22, 41

workstation guidelines 27
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